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Overview

Introduction

The Instrumentation Viewer is avisuaization tool that helps you understand the behavior
of running software and investigate its performance. It uses plug-in viewersto display
the data produced by the MacOS Instrumentation System. Y ou can configure a set of
viewers to show particular instrumentation data and save the configuration as a
document. A document may be reused to display subsequent runs of the same data.

The MacOS Instrumentation System provides two servicesto its clients. Thefirst allows
aclient to define anamed event. Whenever the client determines that the event has
occurred, it informs the instrumentation system. The instrumentation system creates an
event record, including the event identifier and its time stamp, and writes it out to
permanent storage — usually to disk. These event records are called “traces.”

The second service allows a client to create a unique, named container, into which it can
drop numbers of interest. There are avariety of different “container types,” each of which
is suitable for recording a different type of number, such as a count, atransient value, a
value within arange, and so on. The instrumentation system will periodically sample
these containers and write their contents out to permanent storage. Thisdatais referred to
collectively as“ statistics.”

Inside the viewer, al of the different trace event and statistics containers appear within a
tree. Because of this, they are often referred to as, “ Instrumentation Nodes,” or just
“nodes.” (For different reasons, they are also sometimes called “Instrumentation
Classes.”)

Instrumentation Viewer User’s Guide — 1.2.2 1/30/97
Copyright © 1996-1997, Apple Computer, Inc.



EN== Instrumentation Tree e

Mame

<= [ Operating System
3 O Kernel
- [0 Services
B MemAllocatars
[ Runtime
[3 Toolbox
[ Time Objects
alh Tirne Objects
ailh Seconds1904 Objects
sl ETC Clock Sets
all Conversion Fequency
= [0 Testing
[ O Interfacelib it

3] EE

[

4 4 -

The data files produced by the Instrumentation System appear as time-ordered sets of
traces and statistics. For trace nodes there is one record for every event, or in some cases,
one record for the beginning of the event and one for the end. For a statistics node, there
istypically one datarecord present for each sampling interval, which is usually one
second. (The sampling interval controls how often the current values of the statistics will
be written out.) These time stamped trace and statistics records are referred to generically
as“datapoints’.

The Instrumentation Viewer alows you to create customized views which can be used to
display these data points over time.

For more details on the Instrumentation Library, the services it provides, and how to use
them, see the “Instrumentation Programmer’s Guide.”

Viewer Documents

Documentsin the Instrumentation Viewer have two different modes. Layout mode allows
you to define how the data will be displayed, and Browse mode alows you to view the
data.

The viewer document model is similar to OpenDoc’s. A new document is created initially
empty. Viewers can be dragged from the floating Viewer Palette and dropped into the
document in Layout mode, where they can be moved, resized and configured. Once a
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viewer isin place you can drag instrumentation nodes to it from the instrumentation tree,
to specify the data that the viewer will display. In Browse mode, you can set the display
time; the data corresponding to the this time appears within the viewers.

The source of the information displayed can be "live" data or data recorded during a
previous run. "Live" data can be shown by the viewer when it's running in the presence
of software that is generating instrumentation data, or when connected to a such a system
that is spooling its data to a serial port. Datafrom a previous run is packaged in an
instrumentation data file, which can be viewed at any time.

Once the viewer documents have been set up, atypical session with the viewer consists
of opening existing documentsin Browse mode, selecting a set of instrumentation data,
and using the viewersto look at it.

Viewers

The Instrumentation Viewer supplies one or more viewers for each datatype that can be
recorded by the Instrumentation System.

Trace datais used to record events such as function entry and exit. Clients of the
Instrumentation Library produce trace data by calling InstLogTraceEvent(), optionally
specifying that the call is being made at the beginning of the event, at the end, or
somewhere in the middle. The Instrumentation Library records the nanosecond time
stamp..

The Trace Time Line Viewer shows begin/end trace pairs as ranges on atime line,
and individual traces as points. They are color-coded by instrumentation node. This
allows you to identify clustering of various events, and to pick out relationships between
one event and another.
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The Trace Histogram Viewer displays the traces logged to a set of trace nodes as a
histogram. Using this viewer, you can classify each trace node by the number of timesit
was called. If the trace data consists of start/end pairs, you can aso configure the viewer
to show time spent inside each pair, or the time spent inside each pair exclusive of the
time spent inside another pair in the same task. This last option effectively shows you the
time spent inside a routine minus the time spent inside other instrumented routines that it
cals, directly or indirectly.
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The Trace Histogram Viewer
(Graphical mode)

The Trace Call Profile Viewer displays the distribution of start/end event durations
for agiven trace node. Y ou specify a bucket size in microseconds and it shows you the
number of calls within each bucket.
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Finally, the Trace Text Viewer shows the trace details in text form. It also shows any

Frontwindow() call time

Range (s}
30.34

401, .44

45, 49

S50, .54
55..59

&0, 64
105,109

Count 4
1 =a

&

23

26

2

1
-

The Trace Call Profile Yiewer

additional data supplied by aclient to the InstLogTraceEventWithData() call.
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The Trace Text Yiewer

M agnitude data can be any 32-bit number that a client can measure which increases or
decreases over time. Each data point consists of avalue, the minimum value up to this
point, the maximum value, the total of al values, and the number of times the value was
updated. The last two taken together can be used to calculate the average value. All but
the total are signed 32-bit numbers; the total is a signed 64-bit number. Magnitudes are
typically used to track varying values such as request sizes and operation durations. It can
be displayed graphically using the M agnitude Graph Viewer, and as text with the

Statistics Text Viewer.

Free Pages in RAM

20

The Magnitude Graph Yiewer
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Growth datais arunning total of some client-defined count, such as number of page
faults or cache misses. Clients update growth nodes by calling the instrumentation library
with unsigned 32-bit increments. Each data point consists of avalue, which isthetotal of
all increments passed prior to taking the sample, the minimum increment that was passed,
the maximum increment, and the number of times the total was updated. All but the total
value are 32-bit numbers; the total is 64-hit.

The growth rate can be displayed using the Growth Graph Viewer. Like magnitude,
growth information may be displayed using the Statistics Text Viewer.
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The Growth Graph Viewer

¥M Monitor
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The Skatistics Text Viewer

Histogram data produced by the Instrumentation System consists of a number of
evenly-spaced “buckets’; each bucket has a count. When the client creates the histogram
node, it specifies the width of the buckets and what the total range should be. In order to
generate the data, it periodically callsthe Instrumentation Library with asigned 32-bit
value and a count. If the value falls within the range of a particular bucket, the supplied
count is added to the bucket’ s count. If it does not, then the count is added to a special
bucket called the Overflow bucket instead. Histograms are useful for such tasks as
creating profiles of input parameters.

The Histogram Graph Viewer displays a single histogram in graphical form, asa
series of vertical bars. The Histogram Text Viewer displays a single histogram as
severa lines of text, where each line contains a bucket range and its count. Either one (or
both) may be suitable, depending upon the nature of the data within the histogram and
how many buckets are defined by it.
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The Histogram Graph Yiewer

Tally datais similar to histogram data, in that it is defined by a number of buckets and a
count of the“hits’ in each bucket. However, where the buckets in the histogram are
defined statically when the histogram node is created, the bucketsin atally node are
defined dynamically. When the taly is created, the client specifies how many buckets the
tally isto keep track of. In order to generate the data, the client periodically updates the
tally node with a bucket identifier and a count. If the identifier corresponds to a known
bucket, the count is added to the bucket’ s count. If not, and there are still buckets
undefined, the supplied identifier is given a new bucket whose count isinitialized with
the supplied count. If there are no buckets left undefined, the count is added to the
Overflow bucket.

The Tally Viewer, in text mode, shows alist of the buckets; each line shows one
bucket identifier and its count.
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Bucket Name Count 4
Qaoooa0z 29887 [T
o000 17
0oo0oa0s 2,049
0o00000s 2,139
0ao0oa0T 31 ||
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The Tallv Yiewer

Each of these viewersis covered in more detail in the section, “Viewer Reference.”
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Setting up a Viewer Document

The Viewer Document Window

When you choose “New” from the file menu, or open an existing viewer document, the
Viewer Document window appears. The viewer document can be in one of two modes:
Layout mode, and Browse mode. Layout mode is used to place the appropriate viewers
into the window and to configure them with the instrumentation nodes that they are to
display. Once they have been set up, you can enter Browse mode to display the contents
of an instrumentation datafile.

Slli————————— Untitled 1 Elqgi
i sec 0:10:5¢ 327332 [ | | 1M
Crata: | Fun & - I Carmpare | (no data) - I Crnd-click to place viewer
Page Read Time

200000

o

o] =

The top section of the window contains controls for setting the current view time and
view resolution; it is not active in layout mode. The space just below the time controls
contains popups for specifying the data source. The space below that is used for
displaying viewers.
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Layout Mode

When anew document is created, it isinitially in Layout mode. In addition to the
Instrumentation Tree floating window, two other floating windows may appear: the
Viewer Paette, and the Viewer Options window. If they are not visible, you can show
them from the Windows menu.

Layout mode is used to choose the viewers you want to include in your document, set
their size and position correctly, attach data to them, and configure their options.

Choosing and Placing Viewers

The first step in defining a new viewer document is to decide which viewersto useto
display your data. Some data types may be displayed by severa different viewers. In the
list below, each data type is shown with the icon that the Instrumentation Tree window
uses to represent it.

Data Type Available Viewers

& Trace Trace Time Line Viewer
Trace Histogram Viewer
Trace Call Profile Viewer
Trace Text Viewer

“  Magnitude Magnitude Graph Viewer
Statistics Text Viewer

= Growth Growth Graph Viewer
Statistics Text Viewer

by Histogram Histogram Graph Viewer
Histogram Text Viewer

i Split Histogram Histogram Text Viewer

o Tally Taly Viewer

Each of these viewersis present in the Viewer Palette floating window. Y ou can place a
new instance of any one of them into a viewer document by dragging it from the Viewer
Palette and dropping it into the viewer area of the document window.

Y ou can aso place aviewer by holding down the Command key and clicking the mouse
in the document window where you want the new viewer to go. A popup menu will
appear with the list of available viewers. Choosing one will place an instance of that
viewer at the mouse position.
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Onceitisin place, it isrepresented by arectangular frame and atitle, which is* Untitled”
by default. Clicking on it will select it; the frame shows “marching ants’, and resize
handles appear at the corners. A viewer can be resized from any corner. Clicking on a
viewer without releasing the mouse button allows you to “pick up” the viewer and drag it
to another position within the window.

Holding down the shift key while clicking will select multiple viewers. They can be
copied by selecting “Duplicate’ from the edit menu, or removed by selecting “Clear.”

Selecting asingle viewer also alows you to change its options; see the “ Setting Viewer
Options’ section, below.

Attaching Data to a Viewer

In order to for aviewer to display data, it must be given areference to an instrumentation
node of the appropriate type. It usesthe full pathname to look up the class within an
instrumentation data file, which it then uses to find the data

Y ou supply aviewer with areference to anode by dragging it from the Instrumentation
Tree and dropping it onto the viewer in the viewer document window. If the viewer can
accept the node, the full pathname will appear as text within the viewer. Some viewers
can accept an unlimited number of nodes; others can accept only one or two. (See the
“Viewer Reference’ section for more details.) If you try to drag anode into a viewer
which aready contains as many nodes as it can display, the viewer will reject the drag.

Note that in order to see nodes within the Instrumentation Tree, you must have adatafile
open. Y ou can open afile by choosing “ Open...” from the File menu. Once open, al of
the nodes within the file are displayed inside the Instrumentation Tree floating window. If
more than one datafileis open, a separate Instrumentation Data window will be created
for eachfile.

(Y ou can attach anode to aviewer even if the node is not present inside the
instrumentation data file that the viewer document currently has open. In this case, the
viewer will display the “ Specified Class Not Found” message while in Browse mode.)

In order to remove anode from aviewer, click on the viewer so that it activates, then
click on the pathname to select the node within the viewer. Shift-click to select more than
one node. Choose the “Clear” command from the menu or hit the “Delete”’ key to remove
the node from the viewer.

Note that the data node must be compatible with the viewer that you attach it to. (See
section “Choosing and Placing Viewers’, above, for alist of which data types the
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standard viewers can display.) If you attempt to drag an incompatible node into a viewer,
the viewer will rgect the drag.

Setting Viewer Options

Viewers can be configured to present their datain various ways. Thisis done through the
Viewer Options floating window, which can be displayed in Layout mode by choosing
“Show Viewer Options’ from the Window menu, or by double-clicking aviewer. The
Viewer Options window has a popup menu which allows you to navigate through the
various option sets.

|j:::::::::::::::::::::::: Wiewear |:||:l‘t'il:ll'|5 lliiiniiiiiiiiiiiiiiiiiiii
| Standard Options il I EJEJ

— Yiew Type i
Trace Time Line Yiewer

— Yiew Bounds

Left 'idth 300

— Yiew Title
] Title [Untitled

— Yiew Data from:

@ Prirnary Source

l:::l Cornparison Source

T

o

In order to set the options of a particular viewer, click onit in the viewer document
window to select it. It will display “marching ants’ to confirm that it is selected. Its
current settings will appear inside the Viewer Options window.

Each viewer supports a common set of options, called “ Standard Options’ in the Viewer
Options popup menu. They control the view bounds, view title, and data source. Many
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viewers support additional options. These are documented for each particular viewer in
the “Viewer Reference” section.

Browsing

Browse Mode

Once the viewers have been set up in Layout mode, you can enter Browse mode to
display some data. Select “ Switch to Browse Mode” from the View menu and open an
Instrumentation data file using "Open..." from the File menu, if you have not already
done so.

A document will “remember” an instrumentation data file that is opened within it, and will
attempt to find and open that file again the next time the document itself is opened. If the
datafile is deleted and replaced with another of the same name, the document will open
the new file instead. Y ou can change the active data file by opening another one viathe
File menu and selecting the name of the newly opened file with the "Data:" popup menu.

(If you are suitably equipped, you can also view data“live’. Seethe*Viewing DataLive”
section in the chapter, “Running Live.”)

In Browse mode, the time and time resol ution controls become active. Both the Viewer
Palette and the Viewer Options floating windows are hidden. The time dider works just
like the standard QuickTime control that it resembles. Instrumentation data consists of a
series of points logged over arange of time; the time slider allows you to set where
within the time range you' d like to look.

Viewing the Data

Whenever the time dider is advanced by one position, the viewers display another
“snapshot” of the data at the new time, rather like the frames of amovie. In response, the
various viewers update themselvesin different ways. The Trace Time Line viewers,
Magnitude Graph viewers, and Growth Graph viewers will each move their data over
one dot to the left, displaying the data of the new time in the right-most slot. The
Histogram viewers and Statistics Text viewers may update their values, assuming that
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new datais present in the new interval. The Trace Text viewers will display only the
traces which are present in the new interval.

The beginning of the interval displayed — the “ current time” —is shown in the top-left
corner of the viewer document, beside the time dlider control. It corresponds to the
amount of time that had passed since the Instrumentation Library wasinitidized. The
“current time interval” isthe period of time aslong as the current time resolution (see
below) that begins at the current time. Each viewer displays the data which is most
closaly associated with thistime interval; for more information on each viewer, see the
“Viewer Reference” section.

In order to advance the data by one frame, click on the right-arrow to the extreme right of
the time dlider control. In order to go back one frame, click on the left-arrow besideit.
Clicking on the“play” button on the left side of the time dlider causes the data to advance
continuously. The Instrumentation Viewer attemptsto show the datain real time, but it
does not skip frames, so smaller time steps in complicated viewer documents may cause
the data to advance more slowly. Clicking anywhere in the slider body will cause the
current time to skip to that point.

Some viewers permit interaction: clicking on adata point in the Trace Time Line viewer
will display asummary of it at the top of the viewer; moving the mouse over abar in the
Trace Histogram viewer in graphical mode will show the bar’ s value as text.

Selecting “Copy” from the Edit menu will place a picture of the document on the
clipboard.

It ispossible to use aviewer document to look at an instrumentation data file which
contains no data for the node that the viewer was originally set up with. This can occur
for one of two reasons: the system that produced the file never defined the
instrumentation class node, or the node was defined, but no data was produced for it in
the interval displayed. Inthefirst case, the viewer will display the message, “No Class
Specified.” In the second, it will display, “No Datafor Specified Class.”

Setting the Time Resolution

The time resolution defines the duration of each snapshot. If the time resolution is
500ms, then each snapshot represents 500ms in time; each “frame” is 500ms of the
movie. Large time resolutions can be useful for seeing alot of datain each snapshot;
small time resolutions alow you to “zoom in” for aclose-up look at a period of particular
interest.

The time resolution control isin the top-left corner of the viewer document window, to
the left of the time dlider control. To increase the duration of each snapshot, click the up-
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arrow; to decrease the duration click the down-arrow. The minimum duration is one
microsecond; the maximum is 30 minutes

Using Viewers

Note that each of these viewersis covered in more detail in the section, “Viewer
Reference.”

Trace Time Line Viewer

The Trace Time Line Viewer is used to display the traces of up to eight trace nodes asa
timeline. Timeisrepresented in the horizontal direction; each traceis plotted as avertica
line with its horizontal position representing the time it waslogged. You can useit asa
quick guide to identifying periods of high activity in particular routines, and to correlate
things happening in one area of your software to events occurring elsewhere.

Y ou can aso click on atrace, or on a Start/End trace pair, to see more information
displayed about that particular event.

The viewer’sareais divided into horizontal and vertical bands. The horizontal bands
represent each trace node; the vertical bands represent intervals of time equal to the
current time resolution. The dark vertical line represents the current time; astime
advances, the traces move to the lft.

Trace Histogram Viewer

The Trace Histogram Viewer calculates how many trace events were logged up to the
current time interval for each of aset of trace nodes. It can present the result in atable or
as agraphical histogram. It allows you to get an idea of which of the trace nodesin the
Set are seeing the most activity.

If you log Start trace points at the beginning of a procedure and End trace points at the
end of it, you can also use the Trace Histogram viewer to show the total time spent inside
each procedure. This allows you to examine a set of proceduresto determinewhichis
using the most (or the least) time.
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Y ou can move the mouse over each histogram bar in graphical mode to show a numerical
summary of the datafor each node. Thisisthe same data that appearsin the table when in
text mode.

Trace Call Profile Viewer

The Trace Call Profile Viewer is designed to show the distribution of call timesfor a
particular trace node. It assumes that the trace data consists of start/end event pairs. It
divides the possible call timeinto a number of discrete ranges using a user-defined bucket
size. It then scans through the trace data looking for start/end pairs. Every timeit finds
one, it subtracts the start time stamp from the end time stamp to get the call time. It then
determines the range that the call time falsinto and increments the count of the
corresponding bucket. It ignores middle events and all other traces.

It displaysthe resultsin atable. Each row shows atime range in microseconds and the
number of start/end pairs whose duration fell into that time range. Empty ranges are not

displayed.

Trace Text Viewer

In order to see the “custom data” which islogged along with the trace by a
InstLogTraceEventWithData() call, you can use the Trace Text Viewer. It shows every
trace which is present in the current time interval for asingle trace node. The last column
of isthe“ Trace String,” which the result of the Instrumentation Library taking the custom
data and formatting it into adisplay string. (Y ou can aso retrieve this information by
performing a Text Export on the trace node. See the section, “Exporting Data,” in the
“Utilities” chapter.)

Magnitude Graph Viewer, Growth Graph Viewer

Y ou can use the Magnitude Graph Viewer to produce a two-dimensiona graph of a
single-valued measurement that variesin time, such as the amount of free space in a heap.
Y ou can use the Growth Graph Viewer to produce a two-dimensional graph of arate of
growth, such astotal page faults per second, which is calculated from the number of new
page faults that appear in each sampling interval.

Either viewer can have up to two nodes attached to it; when there are two, one gets
overlaid on top of the other. Since the second node gets drawn last, it often works best if
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the value of the second node is less than that of the first. Y ou can use the Viewer Options
floating window to set the color of each node’s line.

Y ou can use the auto-ranging capability to get an idea of what vertical range will work
best for the data. After that, you can switch to a static range to prevent the display from
rescaling whenever it detects a new maximum.

Asthe data appears, it starts at the right-hand side of the graph and moves left. On the x-
axis, one horizontal pixel represents atime interval equal to the current time resolution;
the value for the current time is shown by the right-most line.

Statistics Text Viewer

Y ou can use the Statistics Text Viewer to get acompact summary of one or more
magnitude and growth statistics. It is most useful when you are only interested in seeing
the current value of a statistic, and do not need to see the entire history.

Normally, four columns of information are presented — the value, minimum, maximum,
and average. Y ou can configure the viewer to hide some of these, so that only the ones of
interest are displayed.

Other Viewers

Y ou can use the Histogram Graph Viewer or the Histogram Text Viewer to examine
histogram nodes. These statistics typically aim at constructing a usage profile of some
operation whose main parameter varies over alinear range, such as amemory allocator
whose main parameter is arequested block size. For histograms with a small number of
buckets, the Histogram Text Viewer provides concise totals for each one. It aso supports
Split Histograms, where the bucket widths are larger in one part of the rangethanin
another. For histograms with alarge number of uniform buckets, or where complicated
statistical patterns might emerge, the Histogram Graph Viewer showsthe dataasa
standard histogram graph.

The Tally Viewer provides asimple view of tally statistics, showing the bucket identifier
followed and its "hit count." Tallies tend to be used for specialized purposes, such as
providing totals for the number of files processed on a per-file type basis.

Finally, the Static Text Viewer is mainly an adornment tool that allows you to add
auxiliary labelsto the viewers that actually display the data.
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Utilities

Comparing Two Sets of Data

If you are interested in comparing two sets of data - perhaps two instrumentation runs
recorded under dightly varying circumstances - you can use the Instrumentation Viewer
to display them both in the same document, synchronized to a single time dlider control.

In order to make comparison data available in a viewer document, you must first open a
datafile using the File menu's "Open..." command or alive data connection, using the
File menu’s"Open Live Data' command. Once you select thisfile or live connection with
the"Data:" popup menu, it becomes the primary data set. Next, select another data set
using the File menu's "Open..." or "Open Live Data' command. Identify this data set as
the "comparison”" data set by selecting its name with the "Compare:" popup menu.

Every viewer hasa*“View Data From:” setting available in the Viewer Options floating
window. It specifies whether aviewer isto draw its data from the primary data set or the
comparison data set. By default, aviewer is set up to display the datafrom the primary
data set. To have a particular viewer show data from the comparison data set, select it in
Layout mode and choose “ Comparison Source” from the “View Data From:” section.

Upon return to Browse mode, viewers configured in thisway will display data from the
comparison data source. The other viewers will display data from the primary data
source, as before. Specifying a comparison data source causes the range of the time dider
control to be reset to include the time ranges of both the primary and comparison data.
Moving the time dider control will advance the data from both data sets simultaneously.

Often, a second instrumentation run will begin at adightly different time than thefirgt.

To compensate for this, you can use the View menu’'s “ Align Comparison Data...”
command to specify the timesin the primary and comparison data sources which are to be
aligned. Thisalowsyou to line up the interesting data in the second set with that of the
first.

Creating Viewer Summary Reports

While the Instrumentation Viewer allows you to examine the data from a single run of
your software, it is often interesting to keep arecord of various results over alonger
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term. Y ou can create text summaries of the data currently displayed, called viewer
summary reports, to assist this process.

Each viewer produces a summary of the datathat it displays. Thus, the form that the
report takes depends upon how the viewers are set up within the document.

In order to create a viewer summary report, open aviewer document, load in an
instrumentation data file using the “Open...” menu item of the File menu, and position the
time dider so that it displays the data that you are interested in. Then, choose “ Create
Viewer Summary” from the Report menu. A standard file dialog will appear: name the
report and choose “Save.” A text file will be created and each viewer will add its own
summary to it.

Each report contains the name of the document used to generate the report and the date.
Also included are the number of traces that were lost due to trace buffer overrun, and an
estimate of how long traces were being lost for.

Not al viewerswill generate report data. Currently, the Trace Histogram viewer writes
out the node name and number of calls for each trace node. If the trace datais set up as
start/end pairs and the trace histogram viewer is configured to display times, then it will
also write out the total time spent, minimum call time, maximum call time, and average
cal time. All times are expressed in nanoseconds.

The Statistics Text Viewer aso writes out a summary. For each node, it writes out the
current value, the number of times the node was updated, the minimum value, the
maximum value, and if the node is a magnitude statistic, the average value. All values are
expressed in the same units that the client used to update the node.

The Trace Cdl Profile, Histogram Text and Tally Viewerswill al write out the tables that
they display.

Creating Trace Ranking Reports

When analyzing data for thefirst time, it is often useful to get a summary of al the traces
inthefile. Thisis particularly true when there are alarge number of different trace nodes.

Using the Trace Ranking feature of the Instrumentation Viewer, you can produce atab-

delimited text file that shows how many traces were logged to each trace node, and how
much time was spent between Start and End events — both cumulative, and exclusive of

instrumented sub-calls.

In order to create atrace ranking report, open aviewer document and load in an
instrumentation data file using the “Open..." menu item of the File menu. Then, choose
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“Generate Trace Ranking” from the Report menu. A standard file dialog will appear:
name the report and choose “ Save.”

Exporting Data

Using the Instrumentation Viewer, you can export some or al of the data pointsin an
instrumentation data file to a tab-delimited text file. This allows you to run scripts on the
data to further filter or processit, and to import it into a variety of spreadsheet, data-
analysis, and presentation packages for further investigation.

In order to transfer data from an instrumentation data file to atext file, you must have the
instrumentation data file open within a viewer document. It is not necessary that the
viewer document contain viewers associated with the data; an empty document will do.
Select the instrumentation node(s) which contain the data in the Instrumentation Tree
floating window and choose “ Export Data’ from the File menu. A Standard File dialog
will appear; give thetext file aname and choose “Save.” The Instrumentation Viewer
will convert all the data points associated with the selected nodes to text and write them to
thefile.

In the text file, each node will be prefixed by the full colon-delimited path of its node
name, and aline of column headers. Below the column headers will be the dataitself; one
data point to aline. Where time stamps are included, they are expressed as nanoseconds.

Normally, data points are exported in time stamp order. There is one exception to this
rule: when trace datais exported, trace events marked as Start, Middle or End events and
linked together by a common trace tag will be grouped together. This simplifies any
analysis which wishes to treat these traces as a single event.

Saving Trace Subsets

Although it may be valuable to keep an individual record of every trace logged, the
disadvantage of doing so isthat the trace files can become very large. Browsing a 25MB
file can take along time, simply because of the volume of data that must be read.

The Instrumentation Viewer allows you to specify a subset of the trace eventsin afileand
save them into a second file. To do so, select the trace classes that contain the interesting
traces in the Instrumentation Tree window. Then activate the viewer document window
that is displaying the data file and select the time range containing the interesting data.
Thisis done by holding down the Shift key when you move the time slider control.
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Finally, select “ Save Traces’ from the File menu. A Standard File dialog will be
presented; name the file and choose “ Save.” The Instrumentation Viewer will produce a
second instrumentation data file that contains only the trace events in the specified time
belonging to the specified trace classes.

If you do not choose atime range, every trace event belonging to the selected trace
classesis saved into thefile. If no trace classes are selected, every trace event in the
specified time range will be saved.

Printing

The Instrumentation Viewer can print the contents of its viewer document windows. To
do so, open the viewer document that you are interested in printing, and load its
instrumentation data file. Position the time dlider so that the viewer document displays the
data that you wish to print. Select “Page Setup” from the File menu to ensure that the
correct printer has been chosen and that it’ s options have been set up correctly. Then
select “Print” from the File menu.

Selecting “Print One” from the file menu automates the Page Setup and Print steps. 1t will
print asingle copy of the document with the current Page Setup options. If no Page Setup
options have been specified, it will use the printer’s default settings.

Running “Live”

Viewing Data Live

Y ou can watch the performance data asit is being generated by running the
Instrumentation Viewer on a system with active Instrumentation Spoolers. To do so,
launch the viewer and select the "Open Live Data' menu item from the File menu. Active
Instrumentation nodes will appear within the "Live Data" Instrumentation Tree floating
window.

In Browse mode, clicking the “play” arrow of the time control will continually advance
the time as new instrumentation data. comes in. Whenever the dider is up against the right
side of the time control, the most recent timeinterval is being displayed. The dider can be
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dragged backward and forward without disrupting the data flow. It isaso possibleto
enter Layout mode to reconfigure the viewer document and return to Browse mode
without losing data.

Controlling Instrumentation

Y ou can use the Instrumentation Viewer to turn data collection on and off for individual
instrumentation points, or for every active point in the system.

If you are using the Instrumentation Viewer to view live data, the Instrumentation Tree
window will display two additional columnslabeled N and C. When you click on the dot
inthe N column of an active instrumentation node, the node will be enabled and the dot
will turn green. Clicking the dot again will disable the node. The spoolers only collect
data from enabled nodes.

The“C” column isnot yet operational.

A viewer document window that is displaying live data contains a*“ Collect data” check
box. Unchecking it will disable every instrumentation node. Checking it will re-enable all
nodes which were previously enabled.

Reference

Viewer Reference

The following sections provide a detailed reference to the operation and options of each
of the viewers included in the standard release of the Instrumentation Viewer. The icons
to the left indicate the instrumentation data type(s) that the viewer can display.

E Trace Time Line Viewer

The Trace Time Line Viewer displays trace data for up to eight trace instrumentation
nodes on atimeline. Itsdisplay is divided into a number of vertical segments. Each
segment represents a period of time equal to the current time resolution, shown in the top
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left-hand corner of the viewer document window. The dark vertical line indicatesthe
position of the current time, which is aso shown next to the time dlider control.

Traces are represented within these segments by colored vertical lines. By default, each
trace node is given adifferent color. If there are multiple trace points for the same nodein
the sameinterval, they are staggered vertically so that they do not overlap. If the trace
dataincludes Start/End trace pairs, then a horizontal line connects each start/end pair. The
viewer matches up the start and end events by looking for a matching event tag within the
trace records.

If atraceisclicked on, it is highlighted and a summary of the point is presented at the top
of the viewer. It shows the trace type (Start, Middle, or End), the event tag, and the time
the event was logged.

If the linejoining astart/end pair is clicked on, the summary includes the times of the start
and end events, the time between the start and end events, and how many traces were
recorded for that event. (This includes middle events with the same event tag.)

Hitting the Tab key will cause the selection to move to the next event of the selected node.
Shift-tab will move to the previous event of the selected node.

Option-clicking inside arow will search forward for the next trace belonging to that node.

Y ou can zoom in to a particular set of points by clicking and dragging out arectangle.
The viewer will zoom in and adjust the current time to best display the points within the
rectangle, to the closest degree alowed by the fixed set of view time resolutions.

Options

Each node can be configured separately with a number of options. Choosing “Trace
ClassN Info” from the popup menu in the Viewer Options floating window will show the
options for the Nth class displayed. For each class, the color shown in the popup menu is
the onethat is used to draw the trace events. Selecting “ Default Name” will cause the
traces to be labeled with the name of the instrumentation node; selecting “ Custom Name”
allows adifferent name to be used. Checking “Match Paired Events’ will cause the line to
be drawn between matching Start and End events; checking “ Show Middle Events’ will
cause the events between them to be drawn.

Additionally, there are two “Time Line Options’ which apply to the viewer asawhole:
Allow User Interaction, and Display Class Labels. Thefirst creates the area at the top of
the viewer for the point summary and fillsit in when apoint is clicked. The second
causes the names of the classes to be drawn above their traces. Both are on by default,
but may be turned off to reduce the screen space that the viewer requires.
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B Trace Histogram Viewer - Text Mode

The Trace Histogram Viewer counts traces from the beginning of the file to the end of the
current timeinterval. It can display the results either astext in atable, or as a histogram.
This section describes the text mode and common viewer operations; the next section,
“Trace Histogram Viewer: Graph Mode,” describes the graphical histogram mode. For a
description of the Instrumentation System’ s trace data, see the “Viewers’ section in the
“Overview” chapter.

By default, the Trace Histogram Viewer is configured to display the number of times an
event was logged against each trace node. If the data was recorded as a series of
Start/End traces pairs, then the viewer can also display the total amount of time that was
spent inside the Start/End pairs, which normally corresponds to the amount of time spent
inside a particular routine. The viewer can also show the total time spent inside the
Start/End pairs minus the time spent inside other Start/End pairsin the same time interval.
This normally corresponds to the time spent inside a particular routine, minus the time
spent inside al other instrumented routines that it called.

(Be careful, however, asit is not required that al routineslog their start/end pairs within
the scope of asingle routine. For example, consider the case of an asynchronous
PBWrite call with acompletion routine. The start trace could be logged just before calling
PBWrite, and the end trace could be logged inside the completion routine. If another Start
traceislogged after the PBWrite call returns but before the completion routine is run, the
instrumentation system will interpret that as a sub-call of the PBWrite trace.)

When counting trace events, the Trace Histogram Viewer counts all traces except Middle
and End trace points. Thisisto ensure that multi-part events are correctly accounted for.

When calculating Time Spent, the viewer counts all Start/End pairs where both the Start
and End events appear either before or within the current time interval. Thus, athough a
Start event for a node may appear within the current time interval, it is not included in the
trace histogram totals until the current time is advanced to include the corresponding End
event aswell. Eventsthat are not part of a Start/End interval do not add time to the total.

Y ou can place as many trace nodes as necessary into this viewer; each node isidentified
by its class name.

When in text mode, the results are displayed in a table. Each row represents a trace node;
thefirst column is the class name of the node. The second column shows the trace count
— the number of trace events present up to the current time interval. If the viewer is
configured to display Time Spent, the third column displays the total time spent between
start/end pairs up to the current time interval, in microseconds. The fourth, fifth and sixth
columns display the minimum start/end time, the average, and the maximum time,
respectively. (For amore detailed display of the call time distribution, see the “ Trace Call
Profile Viewer” section.)
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Thereisa“zero” button in the upper left-hand corner of the viewer. Pressing this button
will set the “zero point” of the histogram to the current time. All totals are set to zero, and
counting begins from the zero point. Y ou can set the zero point repeatedly, to any point in
the time range. Closing and reopening the document will also reset the zero point.

Clicking on a column header will sort the data by that field. The dataisresorted asitis
updated.

Options

The Trace Histogram Viewer supports asingle set of options, accessed viathe “Trace
Histogram Options’ item of the popup menu in the Viewer Options floating window. It
controls the counting mode of the histogram, and how the results are displayed. By
choosing the appropriate radio button, the viewer can be configured to count the number
of cals , the time spent between Start/End trace pairs, or the time spent exclusive of calls
to instrumented subroutines.

Choosing “Text Histogram™ will cause the viewer to show the trace countsin atable, as
described in this section. Choosing “Histogram Graph” will cause the viewer to display
the results as agraphical histogram, as described in the next section.

The vertical range of the histogram is set in the “Range” text box. If the viewer is
counting calls, the range should be specified as a number of cals. If it is calculating time
spent, the range should be given in microseconds. The range has no significance when
the viewer isin text mode.

B Trace Histogram Viewer - Graphical Mode

Most of the information in the previous section a so applies to a Trace Histogram Viewer
in graphical mode. This section describes features specific to the graphical mode.

When in graphical mode, the viewer shows the display limit of the histogram in the top
left-hand corner, above the vertical axis. Thisisacount if the viewer is set to display the
number of cals; if the viewer is set to display times then the number will bein
microseconds. If the value of particular bar exceeds the display limit, then the bar is
shown “broken” at the top.

The bars are labeled along the horizontal axis. Each bar corresponding to a particular trace
node is labeled with that node’ s class name.

When the mouse is moved over abar in the histogram, the viewer shows numerical
valuesfor it at the top of the display. If the viewer is displaying Number of Calls, thisis

* Which corresponds to the number of non-middle, non-end trace points encountered.
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just the count. If the viewer is displaying times, it shows the total time spent within the
Start/End pairs - which corresponds to the bar height - the minimum Start/End interval
logged, the average, and the maximum. The format is Total Min/Avg/Max.

If there isonly one trace node present in the histogram, the text summary is aways
shown.

In graphical mode, the zero button is placed at the origin of the histogram. It operatesin
the same way, regardless of mode.

E Trace Call Profile Viewer

The Trace Call Profile Viewer shows the distribution of call times for asingle trace node.
It can show you how long the majority of the callsto a particular routine took, how much
variance of call time there was, and how many outliers turned up at the extreme edges of
the range. This can help you to decide whether worst-case optimization is justified.

The display consists of a series of rows. The first column of each row shows atime
range in microseconds. The second column shows how many start/end pairs were
encountered whose end time stamp minus the start time stamp fell into that time range.
The rows are sorted by time range; rows which do not contain any events are not shown.

Clicking on acolumn header will sort the data by that field. The datais resorted asit is
updated.

Calls on the edge of abucket are assigned on the basis of where they fall with respect to
the lower limit of the bucket. For instance, a call whose time was 49.85us would be
counted in the 45..49us bucket, not the 50..54ys bucket.

Options

Thereisasingle Trace Call Profile Viewer option: the time range bucket width. By
changing this value, you can control the granularity with which the viewer reportsits
findings. A small bucket width will produce alarger number of ranges with a smaller
total in each range; alarger bucket width will produce fewer ranges containing more
events.

E Trace Text Viewer

The Trace Text Viewer displays all the trace data points in the current time interval for a
single node. The traces are displayed as lines of text showing the time stamp, Event Tag,
and event order (Start, Middle, or End).

Instrumentation Viewer User’s Guide — 1.2.2 1/30/97
Copyright © 1996-1997, Apple Computer, Inc.



Thereisaso acolumn for “Trace String.” In addition to the trace data described in the
“Viewers’ sectioninthe”Overview” chapter, the client of the Instrumentation Library can
define and record private data at runtime through the use of the
InstLogTraceEventWithData() call. This datais formatted by the Instrumentation Library
astext using printf-style descriptors, and displayed as the Trace String by the viewer.

Options

The Trace Text Viewer options consist of a series of check boxes that control the
visibility of the various columns. The trace time stamp, event tag, event order and trace
string can all be turned on or off. There are aso check boxes for showing the trace's
kernel process name, task hame, and task priority; these options are currently
unsupported by the Instrumentation Library.

ah Magnitude Graph Viewer

The Magnitude Graph Viewer displays instrumentation magnitude data. The data point
displayed is the last sample taken prior to the current time. Since thisis a dtatistic, thereis
typically one data point present for each sampling interval during which the node was
enabled to record data.

The dataiis presented on atwo-dimensional graph, with time along the horizontal axis and
magnitude value along the vertical axis. The vertica axisis labeled with the magnitude
range at top and bottom.

The data appears as vertical bars. The bar that appears on the right-most edge of the graph
corresponds to the data point at the current time - the time which is shown beside the time
dider control. Barsto the left of it represent successively earlier times, with each pixel
representing the current time division. For example, if the current time divisionis 2
seconds, then four adjacent bars cover atime span of 8 seconds.

The bar height represents the value of the data point; see the section below on options for
more information. When the mouse is moved over data on the graph, the value
corresponding to the point under the mouse is displayed at the bottom of the graph.

It is possible to present two magnitude nodes at once on the same graph; in this case their
bars are drawn in different colors. This viewer cannot show more than two nodes.

Sometimes the viewer will be drawn disabled with the message, “No Data for Specified
Class.” This means that the I nstrumentation Spooler did not sample the node and write
out the results during the current time interval.
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Options

The Magnitude Graph Viewer supports three sets of options. Thefirst controls scaling
and the position of the legend. If scaling is set to “Auto scale”, then the limits of the
vertical axiswill be determined by the range of the data being viewed. In order to avoid
having to scan through the data, the rangeis set dynamically. If adatapoint is
encountered whose value is larger than the current range, the range will be reset to
accommodate the new value. (This can cause the graph to “jump around.”) If “Manual
scale’ is chosen, then the range of the vertical axisis determined by the numbers typed
into the “Min value” and “Max value” boxes. The units are the same as those of the data
being displayed.

The viewer can also display alegend, which shows which color belongs to which node.

The other options control the presentation of the data of the first and second nodes. Each
node may have a different color and line style associated with it. In addition, you can
control how the data magnitude (the height of the line) is calculated.

Choosing “Instantaneous’ will display the last magnitude value set prior to taking the
sample. Choosing “ Sliding Average” will calculate the result by averaging all data points
present in the interval between the current time and the current time minus the time
specified in the “Range”’ box.

The “Exponential Decay” calculation is similar to the “ Sliding Average”, except that the
weight of the datain the average decreases as it occurs further away from the current
time.

“Running Average” is currently unsupported.

4 Growth Graph Viewer

The Growth Graph Viewer displays instrumentation growth data. Sincethisis a statistic,
thereistypically one data point present for each sampling interval during which the node
was enabled to record data.

The dataiis presented on atwo-dimensional graph, with time along the horizontal axisand
growth rate along the vertical axis. The maximum rate displayable at the current scaleis
shown at the top of the vertical axis.

The data appears as vertical bars. The bar that appears on the right-most edge of the graph
corresponds to the data point at the current time - the time which is shown beside the time
dider control. Barsto the left of it represent successively earlier times, with each pixel
representing the current time division. For example, if the current time divisionis 2
seconds, then four adjacent bars cover atime span of 8 seconds.
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The bar height represents the growth rate cal culated from the data point for that particular
time; see the “Options’ section, below, for details on how the growth is calcul ated.

It is possible to present two growth rates at once on the same graph, by dragging two
nodes into the viewer in Layout mode. In this case, their bars are drawn in different
colors. This viewer cannot show more than two nodes.

Sometimes the viewer will be drawn disabled with the message, “No Data for Specified
Class.” This means that the I nstrumentation Spooler did not sample the node and write
out the results during the current time interval.

Options

The Growth Graph Viewer supports three sets of options. The first —“ General Settings’
— controls scaling, the legend, and user interaction. The growth rate can be expressed asa
number of increments per microsecond, millisecond, second, or minute. If scaling is set
to “Auto sca€’, then the limits of the vertical axiswill be determined by the range of the
data being viewed. In order to avoid having to scan through the data, the range is set
dynamically. If adata point is encountered whose growth rate is larger than the current
range, the range will be reset to accommodate the new value. (This can cause the graph to
“jump around”.) If “Manual scale” is chosen, then the range of the vertical axisis
determined by the growth rates typed into the “Min value’ and “Max value” boxes.

The viewer can aso display alegend, which shows which color belongs to which node.
User Interaction is not currently supported.

The other options control the presentation of the data of the first and second nodes. Each
node may have adifferent color and line style associated with it. In addition, you can
control how the growth rate (the height of the line) is calcul ated.

Choosing “Instantaneous’ will calculate the growth rate by dividing the amount that the
running total hasincreased in the most recent sample by the sample time. Choosing
“Sliding Average” will calculate an average of al of the instantaneous growths present in
the interval between the current time and the current time minus the time specified in the
“Range”’ box.

The “Exponential Decay” calculation is similar to the “ Sliding Average”, except that the
weight of the datain the average decreases as it occurs further away from the current
time.
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“ o giatistics Text Viewer

The Statistics Text Viewer alows you to display both Magnitude and Growth
instrumentation points in a compact text-based display. (For descriptions of Magnitude
and Growth data, see the“Viewers’ section in the“Overview” chapter.)

The datais displayed as lines of text within the viewer, one line to an instrumentation
node. In the default configuration, each magnitude line contains the name of the node, the
value, the minimum value, the average, and the maximum. Each growth node is shown
by the name, the total value, the minimum increment and the maximum increment. Note
that growth statistics are displayed here as totals, not as rates.

See the section on “Options,” below, for more information on configuring the display.

For each node, the data point displayed is the one whose time stamp is closest to (but not
later than) the current time, which is displayed beside the time dider control. If no data
point exists anywhere between the current time and four sampling periods before the
current time, the values are shown as zeros to reflect the fact that the data was no longer
being recorded.

Clicking on acolumn header will sort the data by that field. The datais resorted asit is
updated.

Options

By default, the scaleis 1:1; choosing a different number will cause al the valuesin the
display to be scaled by the new factor. (This option is not currently supported.)

Each of the Vaue, Minimum, Average and Maximum columns may be shown by
checking the appropriate box, and hidden by unchecking it.

s Histogram Graph Viewer

The Histogram Graph Viewer displaysinstrumentation histogram data. Sincethisisa
statistic, thereistypicaly one data point present for each sampling interval during which
the node was enabled to record data. Each data point consists of a count of the number of
“hits” in each histogram bucket, including the Overflow bucket.

The datais displayed as atwo-dimensional vertical histogram, with the bucket ranges
along the x-axis and the counts along the y-axis. Collectively, all the counts represent a
single data point; the one displayed is the one closest to (but not greater than) the current
time.

Instrumentation Viewer User’s Guide — 1.2.2 1/30/97
Copyright © 1996-1997, Apple Computer, Inc.



It is possible to present two histogram nodes at once on the same graph, by dragging two
nodes into the viewer in Layout mode. In this case, their bars are drawn over one another
in different colors. This viewer cannot show more than two nodes.

Sometimes the viewer will be drawn disabled with the message, “No Data for Specified
Class.” This means that the Instrumentation Spooler did not sample the node and write
out the results during the current time interval.

Options

By selecting “General Settings’ in the Viewer Options popup menu, you can set the
horizontal and vertical ranges of the histograms manually, or specify that they be
calculated dynamically from the values of the histogram. (This can cause the bar heights
to “jump around” as new maximums are encountered.) Y ou can also specify whether the
viewer will draw alegend showing which node is drawn in which color. The user
interaction option is not currently supported.

The main and the secondary histogram - if present - may be configured separately by
choosing the “Main Histogram” or “ Secondary Histogram” items from the Viewer
Options popup menu. Y ou can set the color that the bars get drawn in, or specify that
each bar be drawn in adifferent color from its neighbor. Y ou can also set the namethat is
drawn in the legend representing the histogram node, and specify whether the bars be
filled in (the default) or as empty frames (better for displaying two histograms at once).

by Histogram Text Viewer

The Histogram Text Viewer displays instrumentation histogram data for asingle node. Its
function is essentialy the same as the Histogram Graph Viewer (see above); the major
differenceisthat it displaysthe histogram as alist of bucket rangesin one column, with
the counts for each bucket in the other. It's advantage over the graphical versionisthat it
allows you to see exact counts, which is sometimes important.

The Histogram Text Viewer can also display split histograms.

Clicking on acolumn header will sort the data by that field. The dataisresorted asit is
updated.

Currently, it has no viewer-specific options.
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i Tally Viewer

The Tally Viewer displaysinstrumentation tally datafor asingle node. Sincethisisa
statistic, thereistypicaly one data point present for each sampling interval during which
the node was enabled to record data.

Collectively, all the buckets and all the counts represent a single data point; the one
displayed is the one closest to (but not greater than) the current time. In text mode, the
viewer presents each bucket asaline of text; the first column shows the bucket identifier;
the second shows the count. Note that you can sort by either column by clicking on the
column header text. In graph mode, each bar represents the tally count for the bucket
identifier specified aong the horizontal axis.

Sometimes the viewer will be drawn disabled with the message, “No Data for Specified
Class.” This means that the I nstrumentation Spooler did not sample the node and write
out the result at any time from the beginning of the data sample to the current time.

Options

The Tally Display Options enable you to set the display mode to text or graph. The range
of the vertical axis shown in graph mode can be set by typing the appropriate value in the
"Range" text box. Finaly, the viewer can be configured to present the bucket identifiers
in decimal, hexadecimal, or text OSType format.

Static Text Viewer

The static text viewer allows you to place static text into your viewer document for the
purpose of 1abeling other views or for adding notes. Y ou can choose to have the text
appear in alarge or asmall typeface. Choosing “Draw Border Box” from the Viewer
Options window causes the text to be drawn within a box.
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